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Thank you for choosing EmulationPro. We hope you will enjoy using EmulationPro as much as we 
enjoyed developing it. Be sure to keep checking for the latest software releases as EmulationPro will 
continue to evolve over the next years.

This document describes the EmulationPro software and the basics of lighting programming.
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If, after consulting this manual, you still have questions then you can obtain additional information and 
help through the on-line support forum. EmulationPro users and employees of Elation Professional 
share their experiences and tips on this forum. You can *nd the forum at 
http://forums.elationlighting.com.
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1 OVERVIEW

EmulationPro is an advanced and scalable lighting control application. The software is designed to 
control medium to large lighting installations, for both architectural and live-entertainment situations. 

FEATURES

• Cross-platform (Windows, Mac, Linux)

• 20 Universes (10,240 DMX channels)

• Industry-standard Cuelist system

• FX Generator

• Pixel Mapping

• DMX in

• MIDI in & out

• OSC in & out

• UDP in & out

• Art-Net in & out

• Timecode (SMPTE, MTC)

• Astronomical Clock (sunrise, sunset)

• Scheduling (date, time, weekday)

• 2,500+ personality *les

• Optimized for Touch Screen

SUPPORTED HARDWARE

EmulationPro works in combination with the Art SSC and Art IO as its DMX and IO interfaces, the Art B6 
is supported as a remote control unit. All devices are connected by Ethernet. 

Art SSC               Art IO               Art B6
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LICENSING 

The EmulationPro software is available for download. The licence is included in the Art SSC, i.e. each Art 
SSC unlocks 2 universes in the EmulationPro software. The maximum number of supported Art SSCs is 
10.

SYSTEM REQUIREMENTS

Please make sure your system has at least the following speci*cations.

• 32 or 64 bit

• Intel i5 processor of equivalent

• 1GB RAM

• minimal screen resolution of 1280 x 800.

The following operating systems are supported:

• Windows XP

• Windows Vista

• Windows 7

• Windows 8

• OSX 10.5

• OSX 10.6

• OSX 10.7

• OSX 10.8

• Ubuntu 12.04 (for 32 bit)

• Ubuntu 13.04 (for 64 bit)
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2 USER-INTERFACE

The main user-interface of EmulationPro consists of the following sections:
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3 PATCH

The PATCH menu allows you to setup the DMX *xtures which are connected to EmulationPro. 

UNIVERSE

In the Universes tab you can set up the number of DMX universes that you will be using. You can add, 
remove and rename universes. The maximum number universes is 20. Each universe needs to be linked 
to a DMX port on an Art SSC. Each DMX port on an Art SSC can only be linked to one universe. When 
one DMX port becomes linked to a universe then EmulationPro will become the 'master' of this Art SSC. 
The Art SSC will then suspend any standalone operation and become solely an input/output interface 
for EmulationPro. When the DMX port is unlinked from the universe or the EmulationPro software is 
closed, then the Art SSC will automatically resume its standalone operation.

The Art SSC can also 
manually be unlinked 
from EmulationPro by 
disabling the 'Master' 
setting in the universes 
table.

When connected to an 
Art SSC, each universe's 
DMX data can also be 
send out via Art-Net. 
EmulationPro supports 
both broad-cast and uni-
cast for transmitting Art-

Net.

FIXTURE

The Fixture tab allows you to add, remove and change the *xtures in your patch.
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Add

Click ADD to open the Add Fixture dialog. Browse the manufacturers list, and choose the 
MANUFACTURER of the *rst *xture you would like to add. 

To quickly *nd a manufacturer, start typing the name of the manufacturer you’re looking for on your 
keyboard. While typing, the list will jump to the correct manufacturer in the list. Browse the MODELs for 
the selected manufacturer and choose one by clicking it. To quickly *nd a model in a long list, click on 
the “model” list and
start typing the name of
the model you’re
looking for. 

If you would like to
choose a *xture that is
not present in these
lists then please refer to
page 37 to see how to
obtain new personality
*les.

Remove 

To remove one or more *xtures from the patch, select them in the Patch view by clicking or dragging 
and click REMOVE. To remove all *xtures, click REMOVE and keep the button pressed for at least 1 
second. 

Replace 

If you have pre-programmed a show with your *xtures, and *nd out these *xtures are running in a 
diKerent mode or are even a completely diKerent *xture when on location, then you can 'replace' these 
*xtures. Select the 'manufacturer's' *eld of *xtures you would like to replace by clicking or dragging in 
the Patch view and click CHANGE. This will open the CHANGE FIXTURE dialog, which is similar to the 
ADD FIXTURE dialog. Choose another mode for the same model, or choose even another model. 

Rename

To give your *xtures a more clear name, select the 'label' cells of 1 or multiple *xtures and press 
CHANGE. Type a new name for the *xture and click OK or press <ENTER.>. If you’ve renamed multiple 
*xtures, EmulationPro will automatically add 01, 02, 03 etc. to the name you have entered. 

Address

EmulationPro automatically sets the DMX
address when adding *xtures to the patch, by
*nding the *rst available DMX channel in your
con*guration. However, if you want to change
the address, select the 'address' cell of 1 or
multiple *xtures and click CHANGE. Enter the
new address and click OK. 

If you had multiple *xtures selected,
EmulationPro will set the entered address for the *rst selected *xture and will automatically have the 
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next selected *xtures follow the previous ones. For example, if you select 4 8-channel dimmers in the 
patch, click ADDRESS and enter “101”. This will result in addresses 101, 109, 117 and 125 for the selected 
dimmers. 

Properties

Selecting the 'properties' *eld of a *xture and clicking on the CHANGE button will pop up the Fixture 
Properties window. 

This window allows you to enable INVERT PAN,
INVERT TILT and SWAP PAN TILT in case the
*xture is a moving light. 

If the *xture has RGB colour mixing but no DMX
channel for intensity, you can enable VIRTUAL
DIMMER. This option will give the *xture
dimmer capability separate from the RGB
control. 
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4 MATRIX

EmulationPro contains a 2-dimensional matrix controller for pixel mapping on arrays of lighting *xtures. 
These lighting *xtures are typically LED *xtures, however, the matrix control can also be applied to any 
other DMX *xture.

LAYOUT

To control a matrix you *rst patch the *xtures as usual in the Patch menu. The next step is to add only 
the *xtures that are part of the matrix to the members list in the Matrix->Layout menu. In this tab you 
can also set the width and height of the matrix.

Next you should arrange them to reOect the physical location of the *xtures. In the Layout tab you can 
select a matrix-member and then move it around using the arrow-keys. Alternatively, you could use 
ARRANGE ALL button to
have all the members
automatically positioned
according some typical
patterns.

To assist you in
establishing the layout you
can enable the INDICATE
check-box, this will make
the lighting *xture to
display the same colour as
used in the layout diagram. This will speed up the process because it helps you with recognizing which 
*xture is selected and how it is orientated.

LAYER

Once the layout is created you should add at least one layer in the Layer tab. Typically this layer has the 
same dimensions as the matrix; this is quickly achieved by pressing the FULL SIZE button.

Each layer can playback a
graphical eKect. When you
add more layers then this
will allow you overlay
multiple eKects and cross-
fade or blend layers into
each other.

By reducing the size of the
layer you can create
picture-in-picture eKects.
Also, when two separate
matrices are patches next to each other in the layout then both could be covered by a separate layer; 
thus allowing independent control of multiple matrices within EmulationPro.
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PATTERN

The Pattern tab shows the eKects
that are available to be played
back on the layers. When starting
a new show-*le the patterns are
loaded by default, however, you
are free to add or remove any
pattern. Some patterns have
properties that can be modi*ed by
using the EDIT button.

OVERVIEW

The overview tab renders the
output of the matrix control.

USING THE MATRIX CONTROL

For each layer that you have added a 'virtual' *xture will appear in the status menu. This virtual *xture 
represents the layer. You turn on the layer by selecting it and then creating a scene in the programmer 
window, just like you would be with moving light for example. The layer would need its intensity to be 
brought up and a colour-mix to be set (typically open white), then by using the gobo wheel you can 
select the pattern-page (gobo wheel 1) and the pattern (gobo wheel 2). Some pattern bene*t from the 

gobo scroll to be enabled, 
others require the speed 
parameter that can is 
located on the MISC tab. 
When you like the scene you 
have created for the layer 
then you can record it into a 
palette or cue, just like you 
would do for a moving light 
for example.
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5 GROUPS

You can create groups with *xtures and/or sub-*xtures. This makes selection of multiple (sub) *xtures 
easy and quick.

To create a group you go to the Status menu and follow the steps:

1. Make sure the programmer is cleared (press CLEAR twice)

2. Select *xtures

3. Press RECORD

4. Click on an empty cell in the group grid

You can also edit an existing group
by enabling the EDIT button and
then click on a group cell. This will
bring up the group dialog where
you can add or remove individual
*xtures.

To rename a group you *rst enable
the RENAME button and click on a
cell.

SUB-FIXTURES

EmulationPro uses the concept of sub-*xtures. This means that some *xtures consist of multiple sub-
*xtures, like a 10-channel dimmer rack is - in our terms - just one *xtures with 10 sub-*xtures. This also 
works for LED *xtures with multiple segments/pixels.  The reason behind the concept of sub-*xtures is 
that it makes patching easier; you only add the physical *xtures to your patch and you don’t have to 
worry about setting starting addresses per dimmer channel, or worse, per LED segment. 
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6 PALETTES

Palettes are memories that can contain a single lighting scene for one or more *xtures. This scene can 
contain just a single attribute (e.g. only intensity) or contain multiple attributes. When you activate a 
palette then the scene is loaded into the programmer. 

The palettes are useful for live controlling your lights as you can make quick changes just clicking on 
diKerent palette cells. Also, the palettes can be used to store scenes into cuelists. In that case no actual 
values are stored into the cues, instead a reference to the palette is saved. This allows you to later on 
change the palette and have the change reOected in each cue that is referring to this particular palette.

To create a palette go to the Status menu and simply build a scene in the programmer window, enable 
the RECORD button and then click
on an empty palette cell. You can
also edit an existing palette by
enabling the EDIT button and
clicking on a palette cell. Similarly,
renaming a palette is done via the
RENAME button and then
choosing a palette cell.

When you activate a palette then
the behavior depends on the *xture selection. When no *xture is selected then clicking on a palette cell 
will *rst select the *xture programmed in this palette. Clicking the cell again will activate transfer the 
values to the programmer. If there are already *xtures selected then clicking on the palette cell will 
apply the palette only of the *xture selection. When there are *xtures selected that do not appear in 
the palette then the values inside the palette will still be applied on these *xtures using a “let's make 
the best of it” policy.
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7 CUELISTS

A lighting scene is stored in a 'Cue' and cues are stored in 'Cuelists'. Each cuelist can contain one or 
more cues. You can create multiple cuelists that each control a part of your show, or you can create one 
single cuelist that addresses all your lights.

You can either create and change cues in the Status menu or use the Memories->Cue menu. This 
chapter discusses both approaches.

7.1 TRACKING

Cuelist based lighting controllers can be either tracking or non-tracking. EmulationPro is a tracking 
console. Tracking means that in a cuelist, only changes need recording. If a light has the same value in 
two consecutive cues you don't need to store the second value, instead you make sure the second 
contains 'no' value so the *rst value remains unchanged through those cues. 

7.2 CREATING CUELISTS IN THE STATUS MENU

The fastest way to create cuelists is to do it in the Status menu. Special buttons like RECORD, LOAD and 
KNOCKOUT are provided to make this process intuitive.

Programmer

When recording cues, you *rst have to create a lighting
scene which will be then stored in the cue. The
Programming window is the place where you create the
scene. First you select a *xture, the programming
window will update to show you the capabilities of that
*xtures and enables you to set the diKerent parameters,
e.g. set a dimmer level, pick a colour or gobo. You can
now also deselect the *xture and select a new one; the
values will be kept in the programming window's
memory. 

FX

EmulationPro has an inbuilt FX generator for dynamic 
eKects on the Intensity, Position and ColourMix 
attribute. To enable a FX click on the FX-button close to 
the attribute and choose an algorithm for the FX dialog. 
You also need to set the size, speed and phase levels.

Clear

Any values that reside in the programming windows' memory have priority. For example you might 
have a cuelist running that sets a certain dimmer to 50% but if the programming window contains a 
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dimmer level of 10% for that particular *xture, then this dimmer will be set 10%. Therefore it is important 
to clear the programmer once you're *nished recording cues. 

Press the CLEAR button once for clearing all values for the currently selected *xtures and press it twice 
for clearing all values, even for *xtures currently not selected.

Remove attributes

To remove an attribute from the Programmer-memory to make sure that it will not be recorded in a 
Cue, press the KNOCKOUT button and click the Attribute or Attribute-page in the Programmer to knock 
it out. 

Fine Adjustments

Some *xtures support 16-bit values for controlling their attributes. To make small changes to a value in 
order to take use of very *ne 16-bit control, you can use the CTRL key in combination with the mouse 
wheel to *ne tune a fader's value. 

Flip

A moving light of the yoke type – not a scanner – is, by using its fork and head, able to reach a certain 
position through two diKerent pan/tilt con*gurations. When the programmer is containing position 
values for one or more *xtures you can use the FLIP button to reach exactly the same position by using 
the opposite pan/tilt values.

Record a cue

Once you've built up a scene in the programming window you can transfer the values to a new cue by 
following the next steps.

– Press the RECORD button

– Press the GO button of an empty playback

This will create a new cuelist with one cue that contains the scene from the programmer. The cuelist is 
automatically assigned to the playback. You can repeat this process to add new cues to the cuelist.

Edit a Cue

To edit the cue, *rst make sure the cue is outputted by activating the cuelist and stepping to the cue 
you want to edit using the PLAY button. Select the *xtures you want to change and change the 
attributes in the Programmer. You can also add other attributes
by changing the attributes for the selected *xtures. Other
*xtures can also be added: Select them and change the values
you would like to store in the cue. 

Press RECORD and click on the PLAY button of the cuelist where
the cue you want to edit is active. A window will pop-up, asking
you what to do. Choose MERGE to merge the active information
in the Programmer with the cue.

Remove values or 0xtures from a cue 

To remove values or *xtures from a cue, we’re going to load the
complete cue into the programmer, make the changes, and store the programmer back into the cue by 
replacing the old information. 

Make sure the cue is active by activating the cuelist and stepping to the cue you want to edit using the 
PLAY button. 
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Load the cue into the Programmer by pressing LOAD and clicking on the PLAY button of the cuelist. All 
information in the current cue is now loaded into the Programmer. 

To remove a *xture from the Programmer, select the *xture and press CLEAR in the Programmer once. 
To remove one or more attributes, select the *xtures, press DELETE and click on the attribute or the 
attribute-page; this action will delete the attribute or the complete attribute page from the 
programmer. 

To store the Programmer back into the cue, press RECORD and click the PLAY button of the cuelist 
where the cue you want to edit is active. In the pop-up window, choose REPLACE to replace the cue 
with the information in the Programmer. 

7.3 MODIFYING A CUELIST VIA THE MENU

Next to working in the Status menu, you can also edit cuelists via the Memories->Cuelist menu. 
Although you can create a new cuelist in the CUE menu, the menu is more setup for modifying cuelists 
once created in the Status menu.

To change an existing cuelist, open the Cuelist menu. Select a Cuelist and click EDIT to open the Cuelist 
editor. Here you can edit the properties of the CUELIST and the individual cues.

The following properties can be set for the cuelist: 

Chase 

When CHASE is enabled, the cuelist will no longer follow the cues’ timings and conditions. The cuelist 
will be played back as a chase. The cross-fade can be changed using the ATTAK slider in the playback 
settings. The speed of the chase is linked to the main Chase tempo, which can be found at the bottom 
left of the EmulationPro window. All cuelists set to CHASE will run synchronous to this tempo. 

In the Cuelist Editor, you can also specify a tempo divider for the chase. 

1/1: Chase will step further on every beat of the main chase tempo. 

1/2: Chase will step further once in every 2 beats of the main chase tempo. 

1/4: Chase will step further once in every 4 beats of the main chase tempo 

Etc. 

Loop / Bounce / Random

These check-boxes allow you to change the behaviour of the cuelist. Setting it to Loop will make the 
cuelist repeat itself. Bounce will make it run forwards and backwards. Random will make it jump to 
random cues. 

7.4 MODIFYING A CUE VIA THE MENU

The following properties can be set per cue: 

Label 

The label is the name of the cue for your reference. 

Condition 

The condition speci*es when the cue will be triggered. There are 3 possible Conditions: 
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Halt The cue will be triggered when you press the GO button. 

Follow The cue will be triggered as soon as the previous cue has *nished fading. 

Wait The cue will be triggered autocratically after the previous cue has been triggered. 

Cue Timing 

To explain the diKerent timings in combination with the Cue Condition, see the following diagram:  

Delay 

The delay time (in seconds) is the time between the cue being triggered, and the cue actually starting to 
fade. 

Fade In 

The Fade In time (in seconds) is the fade time for all dimmers fading in (dimmer values going UP) in the 
cue and all other fading attributes (e.g. colour mix, position). 

Fade Out 

The Fade Out time (in seconds) is the fade time for all dimmers fading out (dimmer values going DOWN) 
in the cue. 

Click and drag to select multiple properties for multiple cues, e.g. fade in for multiple cues or delay & 
fade in for multiple cues 
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Edit

The values in a cue can also be edited in the Cue Editor. Select a Cue and click EDIT. 

Insert 

Use Insert to add an attribute to the cue.

Delete 

Use Delete to remove an attribute from the cue. The attribute's column will still show until it is removed 
from every cue. 

Change 

Select one or multiple values and click Change to change the value. 

7.5 WIZARD

The wizard can automatically create
typical cuelists that might have taken
quite a while to program if done by
hand.

To use the generated cuelist, it still has
to be assigned to a playback fader or
button. See page 9 for instructions. 

Chase

The wizard can create a chase over
multiple *xtures. You can select any of
the attributes that is supported by the
*xtures you have selected. The wizard
also oKers diKerent orders in which the
chase can run e.g. Forward, Reverse, Zig
Zag, Synchronous or Random.

Test Sequence

The wizard can make you a cuelist that
contains a sequence of steps for testing
*xtures. Based on the personality *le of
the selected *xture it will generate cues
for each attribute the *xture features. It
is advised to create one test sequence
per type of *xture.
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8 PLAYBACKS

Playbacks are an important element in a cuelist based lighting controller like EmulationPro. Cuelists are 
not activated directly, instead they are assigned to a playback. The playback allows the user to start 
(give the playback a 'Go') and stop ('release' the playback) the cuelist, as well as controlling other 
parameters like intensity, speed, attack, etc. 

There are two types of playbacks, playback faders and playback buttons. They work in a similar way, the 
diKerence is that a playback button does not feature the intensity fader and the Oash button. Therefor 
the playback button takes up less space in the EmulationPro user-interface. Playback buttons are more 
suitable for controlling cuelists that have *xed-value attributes like *xed colours, gobo, prism and 
shutter. On the other hand, playback faders are better suited for controlling cuelists containing level-
value attributes like dimmer, RGB colour, iris, strobe, etc.

Assignment

You can assign a playback in two ways.

Firstly, you can double-click on the 'indicator' just above a playback to bring up the Playback Settings 
view. Pressing the ASSIGN button in this dialog will bring up the assignment dialog.

Alternatively, you can also assign by creating a new cuelist in Status menu, this implicitly assigns the 
new cuelist to a playback. Please refer to the Cuelist chapter for an explanation on how this is done.

Indicator

The small rectangle above the playbacks are called 'indicators', they provide some basic feedback on 
the contents of the playback.
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Speed

The speed fader will control the overall speed of the playback. When set in the middle the speed will be 
neutral; it will not eKect the programmed speed of the cues and fades. 

If the cuelist is set as a chase then the cuelist will no longer follow the cues’ timings and conditions. The 
speed of the chase is linked to the main Chase tempo, which can be found at the bottom left of the 
EmulationPro window. All cuelists set to CHASE will run synchronous to this tempo. In this case the 
Speed slider will specify a tempo divider/multiplier for the chase. For example:

4/1: Chase will make four steps within every beat of the main chase tempo. 

2/1: Chase will make two steps within every beat of the main chase tempo. 

1/1: Chase will step further on every beat of the main chase tempo. 

1/2: Chase will step further once in every two beats of the main chase tempo. 

1/4: Chase will step further once in every four beats of the main chase tempo 

Attak

When the cuelist is set as a Chase, then the cross-fade can be changed using the ATTAK slider.

FXRate

The FXRate will modify the programmed speed for all FX in the cuelists. Keeping this slider in the middle 
will not change the programmed FX speed.

Background

If a playback is set to 'background' then it will start running automatically at the software's startup. 
Also, it will not be released by the 'release all' command (a 'release all' is performed when the RELEASE 
button is pressed for over one second).

The background feature is useful for cuelists controlling *xtures that should not be turned oK during a 
show, e.g. 'work' lights backstage.

Fader Start 

With Fader start enabled, the playback will automatically be triggered when the corresponding fader is 
being moved up or the Oash button is pressed. The playback will also be released as soon as the fader is 
back at the bottom or when the Oash button is released.
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Bundle

You bundle playbacks together so they work mutually exclusive; i.e. only one playback is active at the 
same time. Whenever you start a playback it will automatically release any other playback in the same 
bundle. You can set up up to 20 diKerent
bundles.

Bundles come in handy if you have a couple of
playbacks controlling cuelists for the same
*xtures, especially if those cuelists contain
HTP attributes like dimmer. 

Button Primary/Secondary 

These properties allow you change the function of the Oash button (Primary) and the go+ button 
(Secondary).

Banksafe

Some cuelists you will need to change so frequently, that you would like to access them from each 
bank. In the PLAY menu, you can achieve this quickly by selecting the playback's cell in the table and 
clicking BANKSAFE. 
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9 ACTIONS

EmulationPro needs to respond to the outside world. With today's ever more demanding lighting 
projects, chances are it needs to respond to various diKerent signals or protocols. The EmulationPro 
software supports a variety of protocols. In the Memories->Action menu you determine how your Art 
SSC will respond to which signal and what tasks it will perform when triggered.

This structure consists of action-lists and actions. All the diKerent kind of signals EmulationPro can 
receive are categorized as 'sources'. Each action-list relates to one source and can contain multiple 
actions. Each action details to which speci*c signal it is listening and contains a list of tasks it will 
perform when triggered. Action-lists and actions are further discussed on page 22.

Templates

The Memories->Action menu provides ready-made Templates for several typical action arrangements. 
Templates can be easily copied to the Source list and modi*ed in necessary.

The following table describes the functionality of the templates.

GPI � Dashboard 
Playback Buttons

Control the playback buttons via the GPI port of an Art SSC or Art IO or through the 
push-buttons of the Art B6.

GPI � Playback Fader 
+ Dimmer

Control the playback faders via the analog GPI ports of an Art IO.

eTouch

Creating an eTouch layout is done by creating a 'Touch Screen' action-list and adding actions. For each 
action you can choose between various controls like buttons and sliders. The order of the actions will 
control the arrangement in eTouch.
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ACTIONS

Programming the show controller involves adding action-list and specifying actions.

Action-lists

In the Action-lists table you can include the sources you will be using in your project. You can choose 
from input sources like: DMX, Art-Net, MIDI, GPI, Time-code, Scheduler & OSC. Each Action-list can be 
enabled and disabled.

The available sources are:

Touch Screen Triggers from the eTouch software tool.

Art-Net Trigger on reception of Art-Net or convert Art-Net universes to DMX.

DMX In Convert to complete universe to Art-Net or trigger by individual DMX channels.

MIDI Trigger by or convert from incoming MIDI messages like Notes, Control Changes or 
Program Changes.

Timecode Trigger by exact time-code frames. You specify the time-code protocol in the settings 
page.

Scheduler The inbuilt RTC allows triggering on time, day, weekday and sunrise/sunset.

System Miscellaneous triggers like 'OnStartup'

OSC Incoming OSC messages

GPI State changes on the Art SSC's or Art IO's GPI port.

GPO State changes on the Art IO's relays.

UDP Incoming UDP messages
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Actions

Within each Action-list you can create multiple Actions. For each Action you specify when it will be 
triggered and which Tasks it will perform when that trigger occurs.

To change the details of an action, select it and press the EDIT button. This will open the Action page.

Flank

For most types of actions you can set the Oank. For example when editing a GPI action, it will be 
triggered only on closing the contact (also known as 'normally open') when the speci*er is set to 
DOWN. When set to UP, the action will be only trigger on opening the contact (a.k.a. 'normally closed'). 
Finally, when the speci*er is set to CHANGE, the action will be triggered on both closing and opening of 
the contact.

Trigger

Specify the exact trigger on which to execute the tasks. In the case of a GPI action, the trigger denotes 
the trigger port number (there are 4 ports on the Art SSC and 8 ports on an Art IO). 

Tasks

You can specify up to 64 Tasks per action. When triggered, the Tasks are performed in the same order as 
they are listed in the Action. Tasks can control various elements and protocols in EmulationPro, such as 
playbacks, MIDI, OSC or *xture selection. Tasks can also be used to trigger other Actions, enable or 
disable action-lists and start/stop the internal time-code.

Some tasks manipulate the software entities in the engine and other tasks control the user-interface of 
EmulationPro; the latter are called 'Dashboard' tasks. For example there is a 'Playback Fader' task and a 
'Dashboard Playback Fader' task. The 'Playback Fader' task has features like 'Go+' and 'Release', directly 
changing the state of the playback. The 'Dashboard Playback Fader' task does, however, only control 
the buttons and faders in EmulationPro that belong to that particular playback. This task allows you to 
press and release the 'Oash' and 'go' button. 

Because a Task can do a wide variety of things they are organized in diKerent Task 'Types'. When adding 
a task a pop-up window will allow you to choose from the following types:

UDP Send a UDP message.

DMX Control the DMX channels in the 'Show Control buKer'. This data can be send out via the 
DMX ports and/or Art-Net. Please set the 'Output Routing' in the Settings page 
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UDP Send a UDP message.

accordingly.

MIDI Send a MIDI message.

OSC Send an OSC message.

Timecode Control the time-code properties like selecting the input source or start/stop the internal 
time-code generator.

Selection Control the *xture selection

Special Special tasks like 'run program' to start an external application.

Pattern Change the properties of a pattern.

Action Trigger another action.

Action List Control the properties of an Action-list (e.g. Enable check-box).

Playback Fader Control a playback fader. Use the identi*er *eld to denote which playback.

Playback Button Control a playback button. Use the identi*er *eld to denote which playback.

Dashboard Playback 
Fader

Control the GUI that belongs to a playback fader. Use the identi*er *eld to denote which 
playback.

Dashboard Playback 
Fader Grid

Control the playback faders via an 8x8 grid in the GUI.

Dashboard Playback 
Button

Control the GUI that belongs to a playback button. Use the identi*er *eld to denote which 
playback.

Dashboard Playback 
Button Grid

Control the playback buttons via an 8x8 grid in the GUI.

Dashboard Bank 
Fader

Control the bank selection GUI for the playback faders.

Dashboard Bank 
Button

Control the bank selection GUI for the playback buttons.

Dashboard Master Control the master GUI.

Dashboard Tempo Control the tempo GUI.

Dashboard 
Selection

Control the *xtures selection GUI.

Dashboard 
Programmer

Control the progammer GUI.

Dashboard 
Command

Control the command-line GUI

Serial Send out RS-232 messages.

Led Control the LEDs on an Art B6.

Palette Control the palettes

Dashboard Palette 
Grid

Control the 8x8 palette grid in the GUI.

Universe Set the properties of a universe in the patch view.
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Feature

For each task you can select a Feature.  The choice in Features diKers for each Type. 

DMX features:

Set Value Set a channel

Bump Channel Momentary set a channel to certain value

MIDI features:

Send Send a MIDI message.

OSC features:

Send Send a message with a Ooat type parameter (legacy).

Send Float Send a message with a Ooat type parameter (preferred).

Send Unsigned Send a message with a unsgined type parameter.

Send Bool Send a message with a bool type parameter.

Send String Send a message with a string type parameter.

Send Colour Send a message with a colour type parameter.

Function

Each Task also has a Function *eld. The choice of Functions depends on the Task-Type and the selected 
Feature. For example, when you add a Task with the 'Playback Fader' Type and set its Feature to 
'Intensity' then you can select of the following Functions:

Set Specify an intensity level

Control Set the intensity to the level that is provided as an argument from the source that 
triggered this task. For example, if this task was triggered by the DMX input then the level 
of the DMX channel will be used for the intensity level.
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Scheduling

An important input Source is the Scheduler. The Scheduler uses the computers system time. There are 
several ways to specify a trigger.

Date and Time

You can use the Scheduler to trigger
actions on certain dates and times.
When specifying a date and time it is
possible to choose 'Don't Care' for each
value by entering 'X'. E.g. if you set a
date and specify 'Don't Care' for the year
*eld, this Action will be triggered each
year.

Weekday and Time

Sometimes you would like to de*ne a
trigger based on a day in the week, rather
then a speci*c date. EmulationPro
supports this, it allows to choose any
combination of weekdays and time. 

Astronomical Clock

EmulationPro keeps an astronomical clock that based on the day of the year and position on the globe 
(as con*gured in the settings page) calculates the sunrise and sunset times. This allows you to trigger 
events on sunrise or sunset.
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10 HARDWARE

The EmulationPro software works together with the Art SSC, Art IO and Art B6 hardware. To unlock the 
software you need at least one Art SSC. You can add more Art SSCs to unlock more DMX universes. 
IoCores can be added provide GPI triggers or switch external equipment with the GPO relays. B-Stations 
provide a physical user-interface to select for example cues, palettes or other eKects.

Dumping content into the Art SSC

Once the Art SSC is connected to the EmulationPro software
it becomes 'mastered' and will act as input/output interface;
capturing incoming DMX, MIDI, timecode and GPI triggers in
real-time as well outputting the EmulationPro's data via the
DMX outputs. 

The Art SSC also has many features for standalone usage,
making it a powerful and compact solid-state lighting controller. The lighting scenes can be 
programmed via the Art SSC's web-interface or captured via DMX or Art-Net input. Alternatively, you 
can use the EmulationPro software to program the standalone memory of the Art SSC.

The Art SSC has two type of memory: Cues in the 'console' page and Recordings in the 'Recorder' page; 
both can be uploaded by EmulationPro. To program the cues simply create a lighting scene and dump 
this 'DMX snapshot' into one of the 255 available cues by pressing the DUMP button and entering the 
cue number followed by ENTER. The command-line would show for example:

> DUMP 3

You can also store a cuelist into the recording memory of the Art SSC. First you create a cuelist and 
assign it to playback. Then press the DUMP button, then press the playback's GO button, enter the 
recording number followed by enter. In the command-line it would show like:

> DUMP PB2 12

When the cuelist has multiple cues and their conditions are set to follow, then the complete cuelist will 
be stored taking into account the programmed delay and fade times. 

When the current cue in the cuelist has a condition set to halt, then only that cue is stored. If this cue 
contains any matrix patterns or intensity FX, colour FX or other FX then the duration of the FX will be 
used for the recording. In this case, EmulationPro will automatically make sure the pattern of FX will 
make one complete cycle in order to record a seam-less loop.
When your patch is spread out over multiple Art SSCs, EmulationPro will distribute the generated DMX 
data over the recording in the various Art SSCs.
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11 TEMPO CONTROL

All cuelists with property CHASE enabled, are synced to the Tempo. You can
*nd the controls for the Tempo on the bottom left of the EmulationPro
window . 

Using the TEMPO button below the tempo display, you can tap to the music
to change the tempo in EmulationPro. You can also click the tempo display
and drag up (tempo UP) or to the right (tempo DOWN). 

Break

Click the BREAK button below the tempo display to pause all chases. Click
again to continue all chases. 

MIDI Clock 

When the MIDI Input device you’ve selected in the MIDI Options (see chapter “MIDI Controllers”) sends 
out MIDI Clock messages, the Tempo will be automatically locked to the MIDI Clock tempo. This allows 
exact tempo matching when controlling EmulationPro from sequencer software for example at a 
concert. 

In order for the tempo to be controlled by the MIDI Clock, the display should
be set to 'midi' mode. Press the TEMPO button for more than one second to
switch to 'midi' mode. Press the TEMPO again to switch back to 'manual'
mode.
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12 MIDI CONTROLLER MAPPINGS

EmulationPro supports various MIDI control surfaces. The buttons and faders on those controllers are 
assigned to features in the EmulationPro User-interface in a pre-de*ned midi-map. The following 
diagrams illustrate those assignments.

Generic Midi-map

Next to the hardware speci*c midi-maps, EmulationPro also oKers a generic midi-map in which all the 
software functions that can be controlled through MIDI are assigned to Note or Control Change 
message. This midi-map is intended for use with external MIDI software like sequencers or DAWs.

Elation MIDIcon 

The Elation MIDIcon is supported Plug & Play.
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Behringer BCF-2000 

The Behringer BCF-2000 is supported Plug & Play: However, for optimal use we’ve included a Sysex-*le 
that can either be found in the “Program Files/Elation Professional/EmulationPro/Sysex/” folder on 
Windows systems, or it can be obtained at the forum (http://forums.elationlighting.com). 

The Sysex *le can be uploaded to the BCF-2000 using one of the following (free) tools: 
– Midi-OX for Windows: http://www.midiox.com

– SyEx Librarian for Mac OS X: http://www.snoize.com/SysExLibrarian/

After sending the Sysex *le to the BCF-2000, please notice that the received preset is in a “temporary 
memory”. If you switch oK the BCF-2000, the preset will be lost. When you’ve received the preset on 
the BCF-2000, press STORE, use the PRESET buttons to choose a preset number for storing the preset, 
and press STORE again. The preset will be saved in the BCF-2000.
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Livid Instruments Ohm64 

The Livid Instruments Ohm64 is supported Plug & Play.
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Novation Launchpad 

The Novation Launchpad is supported Plug & Play. 
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Korg nanoKontrol

The Korg nanoKontrol is supported Plug & Play. 
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13 OSC

Open Sound Control (OSC) is a protocol for communicating between computers, software and various 
multi-media type devices. OSC uses the network to send and receive messages, it can contain MIDI, 
time-code and custom information. 

There are apps available for creating custom-made user interfaces on IOS (iPod, iPhone, iPad) and 
Android. These tools allow you to program fool- proof user-interfaces for controlling the device. E.g. 
TouchOSC from http://hexler.net/software/touchosc . 

Remote Control

EmulationPro has an inbuilt implementation for
remote controlling the software by OSC. This
implementation exist independent from any OSC
handling you might program in the action editor.
There is a TouchOSC layout available from 
http://www.elationlighting.com that is con*gured
to mimic the user-interface of EmulationPro. You
can use this OSC layout as a 'rigger's remote' for
controlling EmulationPro by iPad or Android
tablet.

Actions

You can also trigger to incoming OSC messages and de*ne yourself the actions that need to be 
performed. You just add an OSC source to the action-list in the Memories->Action menu and specify the 
actions, triggers and tasks. More information about programming actions can be found on page 21.

Forwarding

The TouchOSC app can only send its OSC messages to one IP address, however, sometimes you need to 
send it to multiple IP addresses. In that case you can use the OUTPUT IP OSC table in the Options-
>Communication->OSC & UDP menu. Simply add IP addresses to this table and enable the FORWARD 
check-box.
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14 OPTIONS

The Options menu enables you to change preferences and view various settings.

GENERAL

This tab enables you to choose a language and a screen resolution. 

The astronomical clock in the EmulationPro calculates the sunrise and sunset times based on day of the 
year, latitude, longitude and UTC values. 

The latitude and longitude values de*ne your position in the world and should be entered in degrees. 
The latitude value should be positive for North and negative for South, the longitude should positive for 
East and negative for West. The website http://www.*ndlatitudeandlongitude.com/  can help you *nd 
the latitude and longitude values for your location.

The time-zone and perhaps daylight saving time of your location is expressed in the UTC (Coordinated 
Universal Time) value. UTC is – in this context – equivalent to GMT (Greenwich Mean Time).

For example, the Dutch city of Haarlem is during the winter we on UTC +1 and in the summer during day 
light saving time it is on UTC +2. So, the settings are:

COMMUNICATION

In this tab you can select the midi-maps for the attached MIDI control surfaces. You can specify two 
MIDI devices.

EmulationPro supports various MIDI control surfaces; it allows you to control EmulationPro' user 
interface (UI) through the buttons and faders on the MIDI controller. The software ships with a list of 
prede*ned Midi-maps. A midi-map *le describes the MIDI controller and how its features (buttons, 
faders, etc) are mapped to the EmulationPro UI. 

To set up EmulationPro for use with your MIDI controller, select the appropriate INPUT DEVICE and 
optionally an OUTPUT DEVICE. The output device is used by EmulationPro to provide feedback to MIDI 
controller's LEDs and motorized faders. Then select the MAP that corresponds to your MIDI controller.

p35

http://www.findlatitudeandlongitude.com/


EmulationPro Manual

Please take into account that the MIDI controller needs to be connected to the computer before 
EmulationPro starts up; EmulationPro only scans for MIDI devices at start up. After that you would need 
to use the REFRESH button to scan again.

Please refer to page 29 for diagrams describing the layout of various Midi-maps. 

This tab also allows you to change the settings for OSC and UDP communication. You can change the 
default network ports used for listening to incoming OSC and UDP messages. Also, you can have 
incoming OSC or UDP messages forwarded to other IP addresses. For this you add the ipaddress:port 
information to the OUTPUT IP OSC and OUTPUT IP UDP tables.

Furthermore, you can specify the incoming time-code protocol used by EmulationPro.

FILE

The File tab allows you to load and save show-*les. A show-*le contains all information about the patch, 
playback assignments, cuelists, etc. You don't need to save your show-*le as EmulationPro will check 
for changes every few seconds and automatically save the *le if needed.

By saving manually and
choosing a name for the
show-*le you can
manage diKerent
lighting projects or
create backup versions.
The show-*les are stored
in XML format at the
following locations:

Windows XP C:\Documents and Settings\[username]\My Documents\Elation\EmulationPro

Windows Vista C:\Users\[username]\Documents\Elation\EmulationPro

Windows 7 / 8 C:\Users\[username]\Documents\Elation\EmulationPro

Mac OS X /Users/[username]/Elation/EmulationPro

Ubuntu Linux /home/[username]/Elation/EmulationPro
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By copying the show-*le you can easily transfer your show between diKerent computers or even 
Operating Systems.

ABOUT

This tab displays the software's version number.
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15 PERSONALITY FILES

Most *xtures diKer in the way how they are controlled by DMX. EmulationPro reads 'personality *les' 
(sometimes referred to as 'pro*les') to determine a *xture's DMX traits. When you patch a *xture you 
need to choose your *xture from a list of supported personalities (as described on page 7). This chapter 
describes how to obtain additional personality *les in case your *xture is not yet present in our list.

16.1 GENERIC

Some types of *xtures typical have identical DMX traits. These common *xtures (e.g. Dimmers, fog 
generators, RGB LED *xtures) are represented in the 'Generic' collection in our library.

16.2 REQUEST NEW PERSONALITIES

Elation Professional provides a free-of-charge service for creating personality *les on request. Please 
make the request on the Elation Professional Forum (http://forums.elationlighting.com) and include a 
link to the user-manual or DMX- chart of your *xture.

When you receive the *le from Elation Professional it needs to be copied into the following location, 
before starting up EmulationPro:

Windows XP C:\Documents and Settings\[username]\My 
Documents\Elation\Common\Personalities\Factory 

Windows Vista C:\Users\[username]\Documents\Elation\Common\Personalities\Factory 

Windows 7 / 8 C:\Users\[username]\Documents\Elation\Common\Personalities\Factory 

Mac OS X /Users/[username]/Elation/Common/Personalities/Factory 

Ubuntu Linux /home/[username]/Elation/Common/Personalities/Factory 

16.3 CREATE YOUR OWN

Sometimes it is better to create your own personality *le, maybe you need it urgently and you're 
outside oXce hours. Or perhaps you don't have a manual available so you would need to create a *le 
through trial-and-error, testing it on the physical *xture. 

For any of these cases we supply an editor for creating the personalities yourself; the Personality 
Builder. It is an external tool for creating and modifying the personality *les used by EmulationPro. The 
Builder is supplied free-of-charge for all EmulationPro users and can be downloaded from 
http://www.emulationcontrol.com/downloads.

For a detailed description of this editor please read its user manual.
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NOTES
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